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KnowItAllトレーニング  官能基解析 - 1 

 

 
 

 
 

KnowItAll ソフトウェアのトレーニング 

官能基解析 

 
 
 
 
 

官能基解析   
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KnowItAllトレーニング  官能基解析 - 2 

このレッスンで使用されるトレーニングファイルは、以
下の場所に保存されています 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\An
alyzeIt IR 

• AnalyzeIt IR Demo Structure.DSF 

KnowItAll 使用アプリケーション 

• AnalyzeIt™  
 

化合物の構造や官能基に基づいてクラスを特定または区別する方法 

 
目的 
 

この演習では、AnalyzeIt IR、AnalyzeIt Raman、および AnalyzeIt Polymer IRのナレッジベースを使用して、化学物質を特定または区別し、構造に基づいてピー

クを関連付ける方法を説明します。 

 

目標 

 

この演習では、以下の内容を学ぶことができます: 

➢ ナレッジベースの指定方法 

➢ 官能基のブラウズ方法 

➢ 構造の相関付け方法   

 

背景 

 

IRおよび Ramanのナレッジベースには、600以上のバンド割り当てが含まれており、これは 200

以上の機能基や一般的な化学クラスに分類されています。 

ナレッジベースを指定 

 アクション 結果 
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1 Spectral Analysis（スペクトル解析）

ツールボックスに移動します。 

 

AnalyzeItをクリックします。 

  

• Open Spectrum（スペクトルを開く） - 任意のスペクトルファイルで始まるファイルを選択します。IR

スペクトルを選択すると、KnowItAllはそれを Organic IRまたは Polymer IRアプリケーションに追加す

るかどうかを尋ねます。 

• Open Structure（構造を開く） - 任意の構造ファイルで始まるファイルを選択します。構造ファイルを

選択すると、KnowItAllはそれを Organic IRまたは Organic Ramanアプリケーションに追加するかど

うかを尋ねます。 

• 同様に、 

o IR Organic - IR Organicを選択すると、空の AnalyzeIt IRアプリケーションが開始されます。 

o Polymer IR - Polymer IRを選択すると、空の AnalyzeIt Polymer IRアプリケーションが開始さ

れます。 

• Raman Organic - Raman Organicを選択すると、空の AnalyzeIt Ramanアプリケーションが開始されま

す。 
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2 それでは、Organic IRの手法から始め

ましょう。 

• Organic IRをクリックしま

す。 

• File（ファイル） > 

Preferences（プリファレン

ス）を選択します。 

Preferences（プリファレンス）のダイアログボックスが開きます。  

 

許容範囲を設定することで、スペクトルのピークとデータベースの一致の精度を調整できます。さらに、スペク

トルパネル内でカーソルが移動すると、波数（x軸の位置）に対応するマーカーを表示することも選択できます。

最後に、使用したいナレッジベースを選択するためのチェックボックスを使用してください。  

3 「UseAnalyzeIt IR Knowledgebase」

が選択されていることを確認してくだ

さい。 

 

OKをクリックします。  
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官能基でブラウズ 

 アクション 結果 

1 Analyze（分析） > Browse a 

Functional Group （官能基をブラウ

ズ）を選択します。 

「Browse By Functional Group（官能基でブラウズ）」のダイアログボックスが開きます。  

 

2 「Aldehydes（酸無水物）」を選択し

て、OKをクリックします。  

「Aldehydes（酸無水物）」タブが AnalyzeIt IRの表示に追加されます。 

 

アルデヒドグループ内の各官能基は、左下の官能基データパネルに個別にリストされています。各エントリに

は、分類、グループ、結合、範囲、強度、モード、ノートなどの情報が含まれています。  

右下のバーチャートパネルに表示される色付きのバーは、官能基データパネルで選択された官能基クラスに関連

するピークを表しています。バーは強度によって色分けされており、明るい色ほど強度が高いことを示していま

す。スペクトルパネルには対応するピークが表示されます。 

 アクション 結果 
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3 再度、「Analyze > Browse a 

Functional Group」を選択し

てください。 

「Browse By Functional Group（官能基でブラウズ）」のダイアログボックスが開きます。  

  

4 「Alcohols（アルコール）」

と「Anhydrides（酸無水

物）」の両方を選択し、OKを

クリックします。  

 

注記：最初のクラスを選択し
たまま、Ctrlキーを押しながら

2番目のクラスを選択してくだ

さい。 

「XREF1」タブが AnalyzeIt IRの表示に追加されます。 

 

このタブは、クラスの組み合わせが含まれる最初のタブであるため、「XREF1」とラベルが付けられています。 
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構造からピークを関連付けます 

 アクション 結果 

1 前の例の表示をクリアするために、「File > Close」を選択しま

す。 

 

「OpenStructure」ボタンをクリックします。 

 

"C:\Users\Public\Documents\Wiley\KnowItAll\Samples\AnalyzeIt 

IR"フォルダに移動します。 

"AnalyzeIt IR Demo Structure.DSF"を開きます。 

ダイアログボックスが表示され、IRまたは Ramanのどちらを選択するかを選ぶよ

うに求められます。 

 

2 Organic IRをクリックします。 ナレッジベースが解析された後、その結果は「Structure」タブに表示されます。

「Functional Group Data」パネルには、構造内で見つかった各官能基のエントリが

含まれています。 
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 アクション 結果 

3 「View > Sadtler Handbook」を選択

すると、特定の官能基に関連するハン

ドブック情報が表示されます。 

「Sadtler Handbook」パネルでは、Functional Group Dataパネルで選択した特定の官能基に関連する Sadtler 

Handbook of Reference Spectra - IRの情報が表示されます。  

 

  

「Sadtler Handbook」パネルのタイトルバーをダブルクリックすると、パネルをメインディスプレイにドッキン

グしたり、ドッキングを解除したりすることができます。  
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このレッスンで使用されるトレーニングファイルは、以
下の場所に保存されています 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\An
alyzeIt IR 

• Peak Interpretation Example.dx (IR)（ピーク解

釈例.dx (IR)） 

KnowItAll 使用アプリケーション 

• AnalyzeIt™  
 

官能基解析   

ソフトウェアを利用した官能基解析を使った基本的なスペクトル解析の手順 

 
目的 
 

この演習では、AnalyzeItアプリケーションを使用して基本的なスペクトル解析を行う方法を説明します。 

 

目標 

 

この演習では、以下の内容を学ぶことができます: 

➢ ピークの相関を選択する方法 

➢ Summary+および Summary-タブの使用方法 

 

背景 

 

AnalyzeItアプリケーションは、200以上の官能基のナレッジベースを活用して、スペクトルの解

釈を支援することができます。このナレッジベースを使用することで、スペクトルや構造から官

能基情報を取得したり、知識ベースに含まれる化学クラスをブラウズしたりすることができます。 
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スペクトルを開きます 

 アクション 結果 

1 スペクトル解析ツールボックスに移動

し、AnalyzeItをクリックします。その

後、Organic IRを選択します。 

 

2  スペクトルパネルで右クリックします。 ポップアップメニューが表示されます。 

 

3 「Open Spectrum（スペクトルを開

く）」をクリックします。 

 

C:\Users\Public\Documents\Wiley\Kn

owItAll\Samples\IR フォルダに移動し

ます。 

「Propyl alcohol（プロピル・アルコー

ル）」を開きます。  

 

OKをクリックします。 

スペクトルが表示されます。 

 

スペクトルを解析 

 アクション 結果 
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1 
ツールバーの「Suggest」ボタン を

クリックします。 

 

アプリケーションは解析対象のピークを自動的に選択します。 

 

一般的には、相関解析を行う場合は、1500以上のウェーブナンバーを持ち、ユニークで強いピークから始めるこ

とが良いです。AnalyzeItアプリケーションでは、適切な出発点を選ぶために一連のルールを使用しています。 

2  まず、再度「Suggest」ツールバーの

ボタンをクリックしてください。 

 

注記：スペクトルパネルをクリックす

ることでもピークを選択することがで

きます。  

別のピークが提案されます。 

 

「Suggest a Peak」ツールバーのボタンを繰り返しクリックすると、アプリケーションは提案された出発点を順

に切り替えます。  
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 アクション 結果 

3 「Suggest」をクリックし続けて、2

番目のピーク（2964の位置にあるピ

ーク）が選択されるまで繰り返

し、その後、「Correlate」ボタン

をクリックします。 

ナレッジベースが解析された後、結果はウェーブナンバーでラベルが付けられたタブに表示されます。  
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 アクション 結果 

4 Functional Group Dataパネルで、アルカンの項目

である C-(CH3)3を選択します。 

 

右クリックして、Summaryポップアップメニュー

を開きます。 

 

注記：Summary+および Summary-タブは自動的

に作成され、測定されたスペクトルと一致するかど

うかや、一致しないかどうかを追跡するために提供

されています。 

 

 



 

108658-REV20230911© 2024年ジョン・ワイリー・アンド・サンズ社による著作権。全著作権保有。 

KnowItAllトレーニング  官能基解析 - 14 

5 メチル基はスペクトルとよく相関しているため、

「Add to Summary+（Summary+に追加）」をク

リックしてください。  

これにより、ピークが Summary+タブと Summary Bar Chart（サマリーバーチャートパネル）（ス

ペクトル表示と Bar Chart（バーチャート）パネルの間）に追加され、Functional Group Dataパネ

ルのこのグループの横にサマリープラスの記号が表示されます。 
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KnowItAllトレーニング  官能基解析 - 15 

 

 アクション 結果 

6 次に、Functional Group Dataパネル

で最初のカルボン酸エントリ（C-C-

COOH）を選択し、右クリックして

Summaryポップアップメニューを開

いてください。 

 

7 結果によれば、1740の領域近くにも強

いバンドが存在するはずですので、こ

のグループを Summary-タブに移動し

てください。 

 

8 Summary+タブをクリックして、この

タブに追加されたグループを表示しま

す。  

 

9 Summary-タブをクリックして、この

タブに追加されたグループを表示しま

す。 

 

10 「File（ファイル）」を選択し、

「Close（閉じる）」を選択します。  

表示がクリアされます。 
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このレッスンで使用されるトレーニングファイルは、以
下の場所に保存されています 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\An
alyzeIt Polymer IR  

• （ポリマーの混合物） 

• Polystyrene.irf 

KnowItAll 使用アプリケーション 

• AnalyzeIt™  
 

官能基解析   

AnalyzeIt™ for Polymer を使用した基本的なスペクトル解析の実行方法 

 
目的 
 

この演習では、AnalyzeItアプリケーションを使用してポリマーの基本的なスペクトル解析を行う方法を説明します。 

 

目標 

 

この演習では、以下の内容を学ぶことができます: 

➢ ポリマーサンプルからのスペクトル解析を行う方法  

 

背景 

 

AnalyzeIt Polymer IR Knowledgebaseは、中赤外線領域における官能基の明確で迅速な検証と識

別を提供することができます。このデータベースには 100以上の官能基と数百の解釈周波数が収

録されています。ポリマーのスペクトルから含まれる官能基を確認し、識別することができます。 
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混合スペクトルを開いて解析 

 アクション 結果 

1 スペクトル解析ツールボックスに移動し、"AnalyzeIt"をクリックし

た後に"Open Spectrum"をクリックします。 

 

2  "C:\Users\Public\Documents\Wiley\KnowItAll\Samples\AnalyzeIt 

Polymer IR。  

 

"Mixture of Polymers.irf"を開きます。  

 

ポップアップダイアログで"Polymer IR"ボタンをクリックします。 

 

注記：IRF、JCAMPなど、特定のスペクトルファイルを探すには

「Files of type」フィルタを使用できます。または、「All files 

(* .*)」を選択することもできます。  

スペクトルが表示されます。 
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 アクション 結果 

3 "Suggest"ボタンを使用して、最も高い

ピーク（1188の位置）を選択し、その

後"Correlate"ボタン をクリックし

ます。 

 

または、ピークをダブルクリックする

と、そのピークが選択され、同時に官

能基の一致を検索するためのナレッジ

ベースを開始することもできます。 

ナレッジベースの解析が完了すると、結果がウェーブナンバー（1188）でラベルが付けられたタブに表示されま

す。 
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 アクション 結果 

4 Functional Group Dataペインの各エ

ントリを順番に選択します。  

 

最初の Poly (2,6-ジメチル-1,4-フェニレ

ンオキシド)がポリエーテルポリマーIR

として適切なマッチとなっていること

に注意してください。  

 

5 エントリを右クリックし、「Add to 

Summary+（Summary+に追加）」を

選択します。 

エントリは Summary+タブに追加されます。  
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 アクション 結果 

6 「Suggest」ボタンをクリックして、3028のピ

ークを選択し、「Correlate」ボタンをクリック

します . 

ナレッジベースが解析された後、結果はウェーブナンバーでラベルが付けられたタブに表示されます。 

 

多くの官能基エントリには詳細なメモが記載されていますので、それに注意してください。  

 
 
 
 
 
 
 
 
 

 アクション 結果 
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7 Functional Group Dataペインの各エ

ントリを順番に選択します。  

 

また、アロマチック炭化水素（ポリス

チレン）のエントリは適切なマッチと

なっていますので、ご留意ください。 

 

8 アロマチック炭化水素（ポリスチレ

ン）のエントリを選択したら、右クリ

ックして「Add to Summary+

（Summary+に追加）」を選んでくだ

さい。 

エントリは Summary+タブに追加されます。  
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 アクション 結果 

9 Summary+タブを開き、両方のエント

リを選択してください。 

 

注記：最初のエントリを選択した後、

Ctrlキーを押しながら 2番目のエント

リをクリックして選択してください。  

これらの官能基が混合スペクトルのほとんどのピークを説明していることに注意してください。 
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単一成分のスペクトルを開いて解析 

 アクション 結果 

1 前の解析を終了するには、右上の閉じるボタンをクリックします。  

2  File（ファイル）> Open Spectrum（スペクトルを開く）を

選択します。 

 

"C:\Users\Public\Documents\Wiley\KnowItAll\Samples\AnalyzeIt 

Polymer IR。  

 

Polystyrene.irfを開きます。 

 

注記：IRF、JCAMPなど、特定のスペクトルファイルを探すには

「Files of type」フィルタを使用できます。または、「All files 

(* .*)」を選択することもできます。 

ポップアップダイアログが表示されます。 
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3 「Polymer IR」をクリックします。 スペクトルが表示されます。 
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 アクション 結果 

4 「Suggest」ボタンをクリックして、

2924.1のピークを選択し、

「Correlate」ボタンをクリックしま

す。 

ナレッジベースの解析が完了すると、結果がウェーブナンバー（2924.08）でラベルが付けられたタブに表示され

ます。 
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KnowItAllトレーニング  官能基解析 - 26 

 

 アクション 結果 

5 Functional Group Dataペインの各エ

ントリを順番に選択します。 

アロマチック炭化水素（ポリスチレン）が適切なマッチとなっていることに注意してください。 

 

6 アロマチック炭化水素（ポリスチレ

ン）のエントリを選択したら、右クリ

ックして「Add to Summary+

（Summary+に追加）」を選んでくだ

さい。 

その官能基が Summary+タブに追加されます。 
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 アクション 結果 

7 再度「Suggest a Peak（ピークの提

案）」ツールバーのボタンをクリック

し、その後「Correlate（相関）」ボタ

ンをクリックします。  

ナレッジベースの解析が完了すると、結果がウェーブナンバー（3024.38）でラベルが付けられたタブに表示され

ます。 
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 アクション 結果 

8 Functional Group Dataペインの各エ

ントリを順番に選択します。 

アロマチック炭化水素（ポリスチレン）が再び適切なマッチであることに注目してください。 
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 アクション 結果 

9 3番目の提案されたピーク（3080.3）

を解析するために、同じ手順を繰り返

し、各エントリを順番に官能基データ

ペインで選択します。 

アロマチック炭化水素（ポリスチレン）が再び適切なマッチであることになります。 
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このレッスンで使用されるトレーニングファイルは、以
下の場所に保存されています 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\IR 

フォルダに移動します。 

• Butylamine.jdx 

KnowItAll 使用アプリケーション 

• AnalyzeIt™ 
 

官能基解析   

ユーザーナレッジベースの作成方法 

 
目的 
 

この演習では、AnalyzeItアプリケーションでユーザーナレッジベースを作成し、使用する方法を説明します。 

 

目標 

 

この演習では、以下の内容を学ぶことができます: 

➢ ユーザーナレッジベースの作成方法 

➢ 官能基のブラウズ方法 

➢ 構造の相関付け方法 

 

背景 

 

ユーザーは、自分自身のデータから官能基とバンドを持つ独自のユーザーナレッジベースを作成

することができます。このユーザーナレッジベースは、KnowItAllのナレッジベースと組み合わせ

て使用され、スペクトル中の官能基を特定するのに役立ちます。 

 

ユーザーナレッジベースを作成する手順 

 アクション 結果 
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1 スペクトル解析ツールボックスに移動

し、AnalyzeItアプリケーションを開き

ます（アイコンをクリック）。 

 

「Organic IR」ボタンをクリックしま

す。 

 

2 Knowledgebase > New（新規作成）

を選びます。 

「Save As（名前を付けて保存）」のダイアログボックスが表示されます。  

3 ユーザーナレッジベース用の名前（例: 

ユーザーIRナレッジベース）を入力

し、ハードドライブ上の適切な場所に

保存します。 

 

ファイルタイプは Sadtler Knowledgebase（*.skbx や *.sbk）と変更できません。  
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4 「Functional Group Tree」ペイン

（左側）で右クリックし、「Add 

Classification（分類の追加）」を選択

します。  

「Classification（分類）」のダイアログボックスが表示されます。  

 

「AmineA」と入力し、OKをクリックします。  

注記: 官能基をブラウズする際に、正しい順序で分類が表示されるように、説明的な識別子を使用してください。

分類名の末尾にユニークな識別子を追加して、エントリが表示されるナレッジベースを特定できるようにしてく

ださい。必要に応じて簡単に変更できます。  
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 アクション 結果 

5 新しい分類名「AmineA」を右クリック

し、「Add Functional Group（官能基

の追加）」を選択します。  

「Add Functional Group（官能基）」のダイアログボックスが表示されます。  

 

6 上部のテキストボックスに「R-CH2-

NH2」と入力します。  

テキストは自動的にフォーマットされます。  
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 アクション 結果 

7 「Browse」をクリックします。 

 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\IR 

フォルダに移動します。  

 

Butylamine.jdxを選択します。 

 

「Reference Spectrum（参照スペクトル）」テキストボ

ックスには、パスとファイル名が表示されます。  

 

  

8 ダイアログボックスを閉じるためには、OKをクリックし

ます。  

 

「Functional Group Tree」で「R-CH2-NH2」を右クリック

します。  

ポップアップメニューが表示されます。 
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 アクション 結果 

9 「Add Band（バンドの追加）」をク

リックします。  

 

NH2と入力し、以下の情報を追加して

ください：  

• 範囲: 1650から 1590 

高さ: 40 

半分の高さの幅: 80 

強度: 中程度から強い 

モード: 変形 

 

OKをクリックします。 

「Band（バンド）」ダイアログボックスが表示されます。  
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 アクション 結果 

10 「Fragment Structure（フラグメント

構造）」ペインをダブルクリックして

ChemWindowを開き、次の構造を描

いてください: 

 

 

11 Save（保存）をクリックします。  構造が表示に追加されます。  
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 アクション 結果 

12 追加のバンドを追加するためには、プロセスを続けてください。  

バン

ド 

位置 高さ 半分の高さ

の幅 

強度 モード 

NH 3400-3320 30 65 中程度 非対称伸縮 

NH 3328-3250 30 65 中程度 対称伸縮 

CN 1090-1068 40 40 中程度から弱

い 

伸縮 

NH 850-750 50 49 強い 揺れ 
 

ナレッジベースの情報は自動的に保存されます。  

 

13 ナレッジベースを閉じるためには、右上の角にある×をクリックしてください。  
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ユーザーナレッジベースを指定 

 アクション 結果 

1 スペクトル解析ツールボックスに移動

し、AnalyzeItアプリケーションを開き

ます（アイコンをクリック）。 

 

2 「Organic IR」、または「Polymer 

IR」、あるいは「Organic Raman」ア

プリケーションをクリックしてくださ

い。 

 

3 File（ファイル） > Preferences（プリ

ファレンス）を選択します。  

Preferences（プリファレンス）のダイアログボックスが開きます。  

4 「Add（追加）」をクリックし、新た

に作成したユーザーナレッジベースを

ブラウズして選択します。 

ユーザーナレッジベースは「Preferences（プリファレンス）」ダイアログボックスに表示されます。  

 

5 「OK」をクリックして「Preferences

（プリファレンス）」ダイアログボッ

クスを閉じてください。  
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6 Analyze（分析） > Browse a 

Functional Group （官能基をブラウ

ズ）を選択します。  

ユーザーナレッジベースの内容が官能基のリストに追加されました。 

  

 


